Geographic information system (GIS) technology is a powerful way to analyze spatial data and is used in many industries to support decision making. From reassigning police personnel on the beat to locating a new housing development, GIS is at the center of important decisions. In *Our World GIS Education, Level 4: Making Spatial Decisions*, you will have a chance to analyze GIS data and learn to make and support spatial decisions.

This scenario-based book presents five modules, each with real-world situations designed to expand your GIS skills as you make decisions using actual GIS data. The projects involve the complicated, sometimes messy spatially related issues professionals from many disciplines face each day. The scenarios are not just step-by-step recipes for you to learn new GIS skills but opportunities to develop your critical-thinking prowess as well. As is true in so many situations, there's more than one “right answer,” and you will have to decide the best solution for the problem at hand.

**How to use this book**

The scenario-based problems in this book presume that you have prior experience using GIS and are able to perform basic tasks using ArcGIS software (we're more specific about our expectations in the “Prior GIS experience” section).

Each of the five modules in this book follows the same format. Project 1 gives step-by-step instructions to explore a scenario. You answer questions and complete tables on a worksheet provided in the book and on your DVD. You reach decisions to resolve the central problem. Project 2 provides a slightly different scenario and the requisite data without step-by-step directions. You need to apply what you learned in project 1. Finally, each module includes an “On your own” section that suggests different scenarios you can explore by locating and downloading data and reproducing the analysis from the guided projects.

You can work through the modules in any order or as assigned by your instructor. You can also do just project 1 or both projects in each module.

**GIS workflow**

One major difference between these modules and other GIS-based lessons you may have done, including those in the three previous *Our World* books, is our focus on the GIS workflow: documenting and being systematic about the problem-solving process. Following a consistent GIS workflow is an important part of becoming a GIS professional.
We recommend the following GIS workflow:

1. Define the problem or scenario.
2. Identify the deliverables (mostly maps) needed to support the decision.
3. Identify, collect, organize, and examine the data needed to address the problem.
4. Document your work:
   a. Create a process summary.
   b. Document your map.
   c. Set the environments.
5. Prepare your data.
6. Create a basemap or locational map.
7. Perform the geospatial analysis.
8. Produce the deliverables, draw conclusions, and present the results.

A more detailed explanation of the workflow is in the “Workflow” section on page xxi.

**Process summary**

The process summary is particularly important because it serves as a record of the steps you took in the analysis. It also allows others to repeat the analysis and verify or validate your results. A process summary might look something like this for an analysis of agricultural land in Vermont. It will, of course, vary for each project:

1. **Examine the metadata using ArcCatalog.**

   **Map document 1**
   1. Prepare a basemap of Vermont.
   2. Symbolize counties in graduated color using the POP2000 field.
   3. Label lakes and major rivers.
   4. Prepare a presentation layout.
   5. Save the map document.

   **Map document 2**
   1. Name the data frame percentage as agricultural land.
   2. Add the land-cover raster.
   3. Symbolize land-cover raster with unique values by land-cover type.
   4. Measure/calculate the area of all land in Vermont.
   5. Select agricultural land cover using the raster calculator.
   6. Measure/calculate the area of agricultural land.
   7. Calculate the percentage of agricultural land.
   8. Prepare a presentation layout.
   9. Save the map document.
The modules

Each module focuses on a different use of GIS for local-level decision making, ranging from establishing evacuation routes during a hazardous material spill to understanding the changing demographic of America’s urban areas to analyzing crime patterns in a city.

Module 1
Hazardous emergency decisions

Accidents, natural disasters, and terrorist acts all involve chaotic homeland security situations that require a coordinated response based on sound information. GIS, when applied to these emergencies, saves lives and property. This module puts you at the scene of two highway emergencies in which hazardous materials threaten a wide area. Your GIS analysis will aid first responders who must deal with evacuating and sheltering people, rerouting traffic, and providing for helicopter access. You will create buffers, analyze traffic patterns, and assess the suitability of school sites as emergency shelters.

Module 2
Demographic decisions

Nearly half the world’s population lives in cities; of the 19 largest cities in 2000, only four are in industrialized nations. Thus, the study of urban demographics spans the globe. In fact, in the twentieth century, the number of city dwellers increased 14-fold worldwide. Demographic data allows you to study population growth trends, aging, housing, income, education, and other factors that play a part in increased urbanization. This module focuses on Chicago and Washington, D.C., two metropolitan areas with complex demographic issues. You will analyze diversity indexes, examine 3D images, create histograms, and calculate housing values in this module.

Module 3
Law enforcement decisions

A geospatial approach to crime fighting helps decision makers deploy limited police resources—personnel, equipment, facilities—for maximum benefit. In this module, we focus on law enforcement in Houston, Texas, and Lincoln, Nebraska, two cities that have successfully incorporated GIS technology into their crime analysis and planning processes. You have the opportunity to use actual data to size up the crime situation in each city and recommend specific action plans based on your GIS analysis. This module involves buffer zones, geocoding, and mapping density. The maps you produce will be the type of effective visual representations that, in the real world, assist decision makers and inform citizens.

Module 4
Hurricane damage decisions

In 2005, Hurricanes Katrina, Rita, and Wilma destroyed homes, businesses, infrastructure, and natural resources along the Gulf and Atlantic coasts. In the aftermath of the storms, federal, state, and local governments, service agencies, and the private sector responded by helping to rebuild the hurricane-ravaged areas and restore the local economies. GIS helped responders assess damage, monitor the weather, coordinate relief efforts, and track health hazards, among many other critical tasks, by providing relevant and readily available data, maps, and images. In this module, you will access some of the same data that guided critical decisions, such as funding and safety measures,
in the wake of Hurricanes Katrina and Wilma. You will map elevations and bathymetry, analyze flooded areas and storm surges, and pinpoint vulnerable infrastructure. In the real world, this process saves lives, time, and money.

Module 5
Location decisions

There's an abundance of spatial data out there to help pinpoint the where. Where should I buy a house? Where should I establish my business? GIS can help gather, analyze, and visualize data to create reliable location intelligence that results in sound decisions. In this module, you will apply similar GIS processes for completely different purposes. Although the scenarios are fictitious, the locations and the data are real. You will study the rapidly growing area of Maricopa County, Arizona, to find a home for a doctor and a teacher with specific requirements. Then, in project two, the scene shifts to Ohio where the task at hand is to find the perfect spot for the fictitious Central Ohio College for the Arts’ student radio station. In this module, you will examine census data, work with weighted overlays, and adjust map projections. These spatial skills can be applied to countless siting decisions large and small.

Assessing your work

Your instructor will talk with you about assessment, but you can assess your own work before handing it in. The items below will help ensure your presentation maps are the best they can be. Think about each of these items as you finish your maps and write up your work.

Map composition

Do your maps have the following elements?

- Title (addresses the major theme in your analysis)
- Legend
- Scale
- Compass rose
- Author (your name)

Classification

Did you make reasonable choices for the classifications of the different layers on your maps? Is the symbology appropriate for the various layers?

- For quantitative data, is there a logical progression from low to high values and are they clearly labeled?
- For qualitative data, did you make sure not to imply any ranking in your legend?

Scale and projection

- Is the map scale appropriate for your problem?
- Have you used an appropriate map projection?

Implied analysis

- Did you correctly interpret the color, pattern, and shape of your symbologies?
- Does any text you’ve written inform the reader of the map’s intended use?
Design and aesthetics

- Are your maps visually balanced and attractive?
- Can you distinguish the various symbols for different layers in your maps?

Effectiveness of map

- How well do the map components communicate the story of your map?
- Do the map components take into account the interests and expertise of the intended audience?
- Are the map components of appropriate size?

By thinking about these items as you produce maps and do your analysis, you’ll make your maps the most effective they can be at solving the problems in each module. See the “Cartographic information” section in the back of the book for more information on cartography basics.

Prior GIS experience

In these modules, we presume that you have used the ArcGIS software before and that you can do the following tasks:

- Navigate and find data on local drives, on network drives, and on CDs and DVDs
- Name files and save them in a known location
- Use ArcCatalog to connect to a folder
- Use ArcCatalog to preview a data layer and look at its metadata
- Add data to ArcMap by dragging layers from ArcCatalog or using the Add Data button
- Rearrange layers in the table of contents
- Identify the table of contents and the map window in ArcMap and know the purpose of each
- Use the following tools:
  - Identify
  - Zoom in
  - Zoom out
  - Full extent
  - Pan
  - Find
  - Measure
- Symbolize a layer by category or quantity
- Open the attribute table for a data layer
- Select features by attribute
- Label features
- Select features on a map and clear selection
- Work with tables
- Make a basic layout with map elements
- Use the drawing tools to place a graphic on the map

If you need some review, there are many great resources available, including Our World Book 2: Mapping Our World Using GIS, Our World Book 3: Analyzing Our World Using GIS, and GIS Tutorial from ESRI Press, and ArcGIS Desktop Help online.
**ArcGIS Desktop software**

The projects in this book use ArcGIS Desktop software. ArcGIS Desktop is part of the ESRI family of GIS software products. Each ArcGIS Desktop product includes two applications: ArcMap and ArcCatalog. ArcMap is used to display and edit geographic data, perform GIS analysis, and create professional-quality maps, graphs, and reports. ArcCatalog is designed for browsing, managing, and documenting geographic data.

The DVD also includes three ArcGIS Desktop extension products used in this book—ArcGIS 3D Analyst, ArcGIS Network Analyst, and ArcGIS Spatial Analyst. ArcGIS 3D Analyst includes the ArcScene and ArcGlobe applications, which are used for three-dimensional visualization and exploration of geographic data. ArcGIS Network Analyst and ArcGIS Spatial Analyst provide tools for specialized analysis tasks.
ArcGIS Desktop includes three license levels: ArcView, ArcEditor, and ArcInfo. ArcView, ArcEditor, and ArcInfo all look and work the same—they differ only in how much they can do. ArcEditor does more than ArcView, and ArcInfo does more than ArcEditor. The DVD included with this book includes the ArcView license of ArcGIS software, but all ArcGIS Desktop products can share the same maps and data.

**Setting up the software and data**

**Using the DVDs**

This book comes with two DVDs. One contains a 180-day trial edition of ArcView for Microsoft Windows. The other DVD contains the data, worksheets, and other documents required for the GIS projects. Refer to the installation guides at the back of the book for detailed system requirements and instructions on how to install the software data. The data license agreement is found at the back of the book and on the data DVD.

If you do not feel comfortable installing programs on your computer, please be sure to ask your campus technology specialist for assistance. The software and data on the DVDs needs to be installed on the hard drive of all computers you will use to complete these modules. Installations on a computer network server are not recommended nor supported.

**Metadata**

Metadata (information about the data) is included for all of the GIS data provided on the Data and Resources DVD. The metadata includes a description of the data, where it came from, a definition for each attribute field, and other useful information. This metadata can be viewed in ArcCatalog. In each project, one of the first things you will do is explore the metadata for the various layers.

**Troubleshooting ArcGIS**

Exercise instructions are written assuming the user interface and user preferences have the default settings. Unless you are working with a fresh installation of the software, however, chances are you will encounter some differences between the instructions and what you see on your screen. This is because ArcMap stores settings from a previous session. This could vary which toolbars are visible, where toolbars are located, the width of the table of contents, or whether or not the map scale changes when the window is resized.

A list of commonly encountered troubles and their solutions can be found on this book’s Web site, www.esri.com/ourworldgiseducation. You may want to print out this list for reference. If you have other software questions relating to this book, you can send e-mail to learngis@esri.com with your questions.

**The companion Web site**

Besides solutions to common problems, the Web site places a variety of GIS resources and other helpful information at your fingertips. For example, you’ll want to check the Web site’s “Resources by Module” section for specific resources, Web links, or changes when you get ready to start a particular project. Any significant changes or corrections to the book will also be posted here.
Addressing and analyzing a problem using GIS requires a structured approach similar to the problem-solving techniques you've done in other disciplines using other tools. With this approach you'll be certain to develop a solution that can be shared with and repeated by other GIS users, and you'll be able to communicate your results successfully to a broad audience.

In this book, use the following steps to define our GIS workflow or procedure. In each project, you'll address each step, in order, as you explore the problems and develop a solution or arrive at a decision. This is not the only way to work through a geospatial problem, but it is widely used in practice. Here are the steps explored in detail in the following pages:

1. Define the problem or scenario.
2. Identify the deliverables needed to support the decision.
3. Identify, collect, organize, and examine the data needed to address the problem.
4. Document your work.
5. Prepare your data.
6. Create a basemap or locational map.
7. Perform the geospatial analysis.
8. Produce the deliverables, draw conclusions, and present the results.

1. Define the problem or scenario

This is perhaps the most difficult part of the entire process. You must define what issue you are trying to address from a sometimes complicated sea of information and perhaps competing interests. This book presents real-world scenarios to help you with this process. You should always try to focus on the core issue in any situation calling for geospatial analysis. What decision needs to be made? Who is going to make it? What do people need to know to make a rational decision?

One approach is to write down a short description of the problem, including the general scenario, the stakeholders, and the specific issues that need to be addressed. It also helps to think about what decisions will ultimately be made using the data. Of course, the scenarios in this book require geospatial analysis using GIS software to solve problems. Other kinds of analyses may be included in these scenarios, but the focus will be on geospatial problem-solving.

2. Identify the deliverables needed to support the decision

After you've defined the problem, you need to think about what maps and other visualizations you'll produce to help you analyze and solve the problem. These may include the following:

- Maps
- Charts
- Tables of calculations
- Written analysis
By envisioning these maps, you’ll be able to identify the data required for your analysis. You’ll also be able to determine if you’ve defined your problem in sufficient detail to develop a solution. Along with specifying your data requirements, your list of deliverables will also guide your analysis. These first steps of your workflow are very iterative. You may need to go through them a few times before you’re convinced that you’re ready to begin your analysis. In many projects, they’re also the most complicated steps.

3. **Identify, collect, organize, and examine the data needed to address the problem**

Once you’ve defined your problem and identified the deliverables, it is time to search for data. As a starting point, you should consider finding data for a basemap and data to solve the problem you’ve defined. In many instances, you’ll have data at hand that will allow you to pursue your analysis. This data may have been provided for you (as in the first two projects of each module) or it may be part of a collection of data where you’re working. It may come from the ESRI Data and Maps collection of DVDs. However, in some instances you may need to get data from other sources, such as Web sites, or you may need to collect your own data. If you need to do some sort of field study to collect your data, you’ll want to be sure to develop a clear protocol for taking data and follow it consistently. You will also want to think carefully about the design of a database to hold your measurements.

In all cases, you should be careful to identify your data sources and make sure you have permission to use the data for your particular problem. You should make sure all data layers have appropriate metadata that describes various aspects of the data, including the creator of the data, its map projection, and the attributes included. You’ll also want to know if you have vector or raster data layers and the accuracy or resolution of each layer.

As you collect the data for your analysis, it is strongly recommended that you adopt a standard for how you organize and store this data. This will make your analysis much easier, and you’ll be able to quickly find different layers and share your work with others. A standard directory structure looks like this:

- Project folder
- Data folder containing all data layers
- Document folder containing all project documentation
- Project.mxd (this is the ArcGIS map document)

You must be able to both read and write to all folders within the project folder. You can place the project folder at a location that’s convenient in the network structure in which you work. Each module shows you how to save your data with relative paths to make data sharing even easier.

When you obtain data from other sources, you’ll often want to take a quick peek at the data to make sure you understand what it actually represents. Remember, these first steps of your workflow are very iterative. You may need to go through them a few times before you’re convinced that you’re ready to begin your analysis. In some instances, you may need to adjust your problem definition to let you use the available data, or the deliverables may need to be modified to make the analysis possible. In many projects, these first few steps are the most complicated.

4. **Document your work**

Documenting your project and creating a process summary is critical to keeping track of the various steps in your analysis. To document your project, go to the File menu and select Document
Properties. In the dialog box that appears, you can enter some of the basic information about your project. A process summary is simply a text document that keeps track of the different steps you use in your analysis. Too often, documentation of GIS work is left to the end of the project or is not done at all. You’re encouraged to start your process summary early in each project and keep up with it as you proceed.

5. Prepare the data
Accurate GIS analysis may call for changing the units in which measurements will be made. You will also want to know the units in which various quantities are measured; are the elevations in feet or meters above sea level? You may need to provide geographic references to certain quantities, such as properly locating addresses or adding GPS-based data to your map display. You will be guided through these steps in the different projects.

6. Create a basemap or locational map
Finally, you’re ready to make maps and perform your geospatial analysis. Your first step in this process should always be to build a locational or basemap that shows the area you are studying. A basemap will typically contain the major features of the area such as roads and streams, and it will help orient you geographically to the area and its features. This is a good practice when solving any geospatial problem as it will give you a sense of the scale of your study area and the different features that may dominate that area.

7. Perform the geospatial analysis
Now it is time to get down to the problem solving. In this step, you’ll apply the different geospatial tools to the data you’ve compiled. These tools include selecting by attribute or location, classifying, interpolating, map algebra, measuring area, or a wide variety of other techniques. The point of your analysis is to produce the deliverables that you specified above and allow you to develop a solution to the problem you defined. Often you will find that the first set of analysis tools may not provide results that help solve the problem and you’ll need to refine your analysis and try other tools or techniques. Even if you’ve been very careful and thorough in your planning to this point, geographic data never loses its ability to surprise you. As you work through the scenarios in this book, you will learn a variety of advanced analysis techniques.

8. Produce the deliverables, draw conclusions, and present the results
Finally, you’re satisfied with your analysis and you’re ready to complete your work. You will first need to complete your deliverables (as defined earlier in the process). This may mean making map layouts, graphs, charts, or tables. You’ll also want to finish documenting your analysis process. Remember to keep the principles of good cartographic design in mind when you make your deliverables. The ESRI “Introduction to Map Design” is an excellent primer on creating high-quality maps. It is included in the documents folder as intrcart.pdf.

You will also need to write a report that states your conclusions and justifies them, using the deliverables you have produced. Always keep the audience in mind as you’re preparing to report your results. A technically savvy audience will have very different needs from a group of high-level decision makers. Remember to finish your process summary.

Congratulations! You’ve finished your project and used a GIS workflow that will lead to success.
Introduction
Accidents, natural disasters, and terrorist acts all involve chaotic homeland security situations that require a coordinated response based on sound information. GIS, when applied to these emergencies, saves lives and property. This module puts you at the scene of two highway emergencies in which hazardous materials threaten a wide area. Your GIS analysis will aid first responders who must deal with evacuating and sheltering people, rerouting traffic, and providing for helicopter access. You will create buffers, analyze traffic patterns, and assess the suitability of school sites as emergency shelters. You will use the ArcGIS Network Analyst extension in this module.

Projects in this module:

- An explosive situation in Springfield, Virginia
- Skirting the spill in Mecklenburg County, North Carolina
- On your own
Module worksheets

The student worksheet files can be found on the Data and Resources DVD.

Project 1 student sheet

- File name: Springfield_student_worksheet.doc
- Location: OurWorld4\Module1\Project1\documents
- Document length: 4 pages
- Worksheet for “An explosive situation in Springfield, Virginia.” A form for answering questions, completing tables, and tracking work to be handed in.

Project 2 student sheet

- File name: Mecklenburg_student_worksheet.doc
- Location: OurWorld4\Module1\Project2\documents
- Document length: 3 pages
- Worksheet for “Skirting the spill in Mecklenburg County, North Carolina.” A form for answering questions, completing tables, and tracking work to be handed in.
An explosive situation in Springfield, Virginia

Scenario
Shortly before 4:00 AM on June 2, 1999, a tractor-trailer rig carrying 34,000 pounds of highly explosive black powder overturned at the “mixing bowl”—the heavily-traveled convergence of Interstates 95 and 495—in Springfield, Virginia. The flatbed tractor-trailer slid from the off-ramp from northbound I-95 onto westbound I-495. The Virginia State Police and the Fairfax County Police jointly provided personnel to coordinate the accident response.
Problem
Fairfax County police officers arrived first, immediately pinpointing the location with GPS receivers and identifying the hazardous substance. The officers accessed the Material Safety Data Sheet (MSDS) online for information about evacuation zones. An MSDS is required by the federal government and provides emergency personnel with proper procedures for handling or working with a particular hazardous substance. Officers needed maps showing the vulnerable area surrounding the accident, an estimate of the number of households to evacuate, suggestions for possible shelters for the evacuees, and a traffic analysis designating detours for vehicles. The analysis would include suggestions for a helicopter landing site both for medical evacuation and to transport personnel for logistical support. The helicopter landing site needed to be near the incident and evacuation zone.

In applying GIS to a problem, you must have a very clear understanding of the problem or scenario. We find it helpful to answer these four questions, which test your understanding and divide the problem into smaller problems that are easier to solve.

**Q1** What geographic area are you studying? (Record answers on your worksheet.)

**Q2** What decisions do you need to make?

**Q3** What information would help you make the decisions?

**Q4** Who are the key stakeholders for this issue? (This step is important. You need to know the audience for your analysis to help decide how to present your results.)

Deliverables
After identifying the problem you're trying to solve, you need to envision the kinds of data displays (maps, graphs, and tables) that will address the problem. We recommend the following deliverables for this exercise:

1. A map of Fairfax County showing roads and schools.
2. A map of buffered areas around the incident. The map should show the following:
   a. Shelter locations
   b. Residences to be evacuated
   c. Helicopter landing site
3. A map showing redirected traffic patterns both around the incident and within the buffer zone.
Examine the data

The next step in your workflow is to identify, collect, and examine the data for the Springfield accident analysis. Here, we’ve identified and collected the data layers you will need. Explore the data to better understand both the raster and vector feature classes in this exercise.

You will use ArcCatalog to preview the GIS data and explore the metadata associated with each feature class. Thoroughly investigate the data layers to understand how they’ll help you address the problem. The spatial coordinate system, the resolution of the data, and the attribute data are all important pieces of information about a feature class.

1. Open ArcCatalog and connect to the folder OurWorld4\Module1\Project1\data.
2. Expand the data folder in the Catalog tree and double-click the Springfield geodatabase. The geodatabase holds two feature classes and an image.
3. Click the Preview tab, then preview the geography and table for each item in the data folder.

Q5 Using ArcCatalog, investigate the metadata and complete this table on your worksheet:

<table>
<thead>
<tr>
<th>Layer</th>
<th>Publication Information: Who Created The Data?</th>
<th>Time Period Data Is Relevant</th>
<th>Spatial Horizontal Coordinate System</th>
<th>Data Type</th>
<th>Resolution For Rasters</th>
<th>Attribute Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>bldg</td>
<td>Fairfax County, VA</td>
<td>2007</td>
<td></td>
<td>N/A</td>
<td></td>
<td>Building attributes</td>
</tr>
<tr>
<td>aerial</td>
<td></td>
<td></td>
<td></td>
<td>N/A</td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>counties</td>
<td></td>
<td></td>
<td></td>
<td>N/A</td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>gschools</td>
<td></td>
<td></td>
<td></td>
<td>N/A</td>
<td></td>
<td>N/A</td>
</tr>
</tbody>
</table>

4. Close ArcCatalog.

Now that you’ve explored the available data, you’re almost ready to begin your analysis. First you need to start a process summary, document your project, and set the project environments.
Organize and document your work

Step 1: Examine the directory structure
The next phase in a GIS project is to carefully keep track of the data and your calculations. You will work with a number of different files and it is important to keep them organized so you can easily find them. The best way to do this is to have a folder for your project that contains a data folder. For this project, the folder called OurWorld4\Module1\Project1 will be your project folder. Make sure that it is stored in a place where you have write access. You can store your data inside the results folder. The results folder already contains an empty geodatabase named project1_results. Save your map documents inside the OurWorld4\Module1\Project1\results folder.

Step 2: Create a process summary
The process summary is just a list of the steps you used to do your analysis. We suggest using a simple text document for your process summary. Keep adding to it as you do your work to avoid forgetting any steps. The list below shows an example of the first few entries in a process summary:

1. Explore the data.
2. Produce a map of Fairfax County showing roads and schools.
3. Identify the incident.
4. Prepare a buffer zone around the incident.

Step 3: Document the map
You need to add descriptive properties to every map document you produce. Use the same descriptive properties listed below for every map document in the module or individualize the documentation from map to map.
1. Open ArcMap and save the map document as **incident1**. (Save it in the `OurWorld4\Module1\Project1\results` folder.)

2. From the File menu, choose Document Properties and in the dialog box add a title, author, and some descriptive text.

   ![](image.png)

3. Click Data Source Options and then click the radio button to store relative paths of data sources. Click OK in both dialog boxes.

   Storing relative paths for data sources allows ArcMap to automatically find all relevant data if you move your project folder to a new location or computer.
Step 4: Set the environments

In GIS analysis, you will often get data from several sources and this data may be in different coordinate systems and/or map projections. When using GIS to perform area calculations, you would like your result to be in familiar units, such as miles or kilometers. Data in an unprojected geographic coordinate system has units of decimal degrees, which are difficult to interpret. Thus, your calculations will be more meaningful if all the feature classes involved are in the same map projection. Fortunately, ArcMap can do much of this work for you if you set certain environment variables and data frame properties. In this section, you’ll learn how to change these settings.

To display your data correctly, you’ll need to set the coordinate system for the data frame. When you add data with a defined coordinate system, ArcMap will automatically set the data frame’s projection to match the data. If you add subsequent layers that have a coordinate system different from the data frame, they are automatically projected on-the-fly to the data frame’s coordinate system.

1. From the View menu, choose Data Frame Properties. Click the Coordinate System tab. Select Predefined, Projected Coordinate Systems, UTM, NAD 1983, Zone 18N, and click OK.

Before using ArcToolbox tools to make your calculations, you will establish some general environment settings that apply to all of the tools you’ll be using. The analysis environment includes the workspace where results will be placed, and the extent, cell size, and coordinate system for the results.

2. Open ArcToolbox, right-click any empty space within ArcToolbox and choose Environments.

3. Expand General Settings.

By default, inputs and outputs are placed in your current workspace, but you can redirect the output to another workspace such as your results folder.

4. Set the Current Workspace as `OurWorld4\Module1\Project1\data\Springfield.gdb`.

5. Set the Scratch Workspace as `OurWorld4\Module1\Project1\results\project1_results.gdb`.

6. For Output Coordinate System, select “Same as Display.”

7. Click OK.
Analysis

Once you've examined the data, completed map documentation, and set the environments, you are ready to begin the analysis and to complete the displays you need to address the problem. A good place to start any GIS analysis is to produce a basemap to better understand the distribution of features in the geographic area you're studying. First, you will prepare a basemap of Springfield, Virginia, showing streets and schools.

Step 1: Create a basemap of Fairfax County

1. From the Springfield geodatabase\Additional Layers, add counties and gschools.

2. From the Springfield geodatabase\Network Layers, add usastreets. The Geographic Coordinate System Warning Menu appears. Click Transformations and choose GCS_WGS_1984 and click OK and then click Close.

3. Symbolize the schools appropriately and import the usa_street layer file. In the Import Symbology Matching dialog box that appears, click OK.

4. Label Interstate 95 and Interstate 495. Interstate 495 is the Capital Beltway and it encircles Washington, D.C. Interstate 95 is the main north-to-south highway along the east coast. Both roads are heavily traveled.

5. Save the map document.

Deliverable 1: A map of Fairfax County showing roads and schools.

Step 2: Identify incident and isolate areas of concern

Upon arriving at the scene, police recorded the coordinates of the incident location as 77°10'33.031"W and 38°47'20.626"N. After questioning the driver of the big rig, officers learned that the black powder was not heavily encased. Knowing the exact nature of the material allowed officers to use their MSDS database.

Open the MSDS stored in the documents folder and determine the extent of the evacuation area around the incident. The police designated an evacuation zone of 0.5 miles around the ramp where the incident occurred.

Q6 How much area needs to be evacuated?

The police team also designated shelters for evacuees within a half mile of the evacuated area.

A. Create buffers around the incident

1. Open a new map document and save as incident2.
2. Refer back to “Organize and document your work” and do the following:
   a. Document the map.
   b. Set the data frame properties. They must be set for each data frame.
   c. Set the environments.

3. Add the bldg, counties, and gschools from the Springfield geodatabase\Additional Layers.


5. Use the Go to XY button on the Tools toolbar and locate the point where the incident occurred. (77°10’33.031“W and 38°47’20.626“N in DMS or 77.175842 and 38.789063 in Decimal Degrees.) Click the Add Point button.

6. Zoom to the point.

7. Use the Select Feature tool and select the ramp where the incident occurred. Right-click usastreets and select Data. Select Export Data and export the selection to the project1_results.gdb in the results folder. Name the file incident. (Note: The file must be saved as a File and Personal Geodatabase feature class.)

8. Deselect the ramp and symbolize the incident layer so it can be easily seen.
9. Open ArcToolbox and expand Analysis Tools, expand Proximity, and double-click Multiple Ring Buffer.
   a. Set the Input feature as incident.
   b. Set the Output feature as buffer (and save it in the results folder).
   c. Distances are 0.5 and 1. (Type the number in the Distances box and then click the + button.)
   d. Make sure the Buffer Unit is Miles.

10. Click OK.
11. Zoom the map view so you can see the entire buffer.
12. Display the buffer by unique value with distance as the value field.
13. Save the map document.

**B. Locate evacuation areas and shelters**

You need to isolate schools that are within one-half to one mile from the accident scene. These schools are potential shelters for evacuees. Note that there are no schools within one-half mile of the incident, therefore no schools need to be evacuated.

1. In ArcToolbox, expand Analysis Tools, expand Extract, and double-click Clip.
   a. The input feature is gschools.
   b. Clip Features should be set to buffer.
   c. Store the output feature in your results geodatabase and name it schools.
   d. Click Save and OK.

2. Remove gschools and symbolize the isolated schools.

To decide how many people must be evacuated, you must isolate the residences within the 0.5-mile evacuation area.
3. Select the buildings from bldg that are single family residential. (Hint: query for Type = SFR. C stands for commercial, I for Industrial, P for Public, and SFR stands for Single Family Residential.)

4. Select the 0.5-mile buffer area only and use the selected buffer. (Hint: Hold down the shift key and use the Select Features tool from the Toolbar to select the 0.5-mile buffer and maintain the building selection.)

5. Clip the bldg layer and name the file sfr and store it in the results folder.

6. Remove bldg and deselect the 0.5-mile buffer zone.

Q7 How many single-family residences are in the danger area?

Q8 Where are the residential buildings located?

Q9 What school would work best as a designated shelter for the people evacuated in the southeast quadrant? (Hint: High schools are usually better equipped to handle large numbers of people.)

Q10 What school would work best as a designated shelter for the people evacuated in the southwest quadrant? (Hint: The school located nearest to the incident would be the best.)

7. Name the data frame buildings and shelters.

8. Save the map document.

C. Choose helicopter landing site

1. Right-click the buildings and shelters data frame and select copy. Go to the Edit menu and select paste.

2. Change the name of the pasted data frame to helicopter site.

3. Add the raster dataset aerial.

4. Make the 0.5-mile buffer hollow or turn on the Effects toolbar and swipe the buffer.

5. Examine the image closely by zooming in and out and pick a place that would be an appropriate helicopter landing site. It should be close to the incident for medical and other evacuations and for the logistical transport of emergency personnel.

6. Place a graphic where you think an appropriate landing site would be and symbolize it appropriately.

7. Save your map document.
Deliverable 2: A map of buffered areas around the incident. The map should show the following:

a. Shelter locations labeled
b. Residences that need to be evacuated
c. Helicopter landing site

For the next part of the exercise you will need to turn on the Network Analyst extension and display the Network Analyst toolbar.

1. Go to the Tools Menu and select Extensions.
2. Check Network Analyst and click Close.
3. To turn on the Network Analyst toolbar, go to the View menu and select Toolbars.
4. Select the Network Analyst toolbar and it will appear.

Step 3: Map detours and best routes to shelters

After the immediate area is secure and the houses to be evacuated have been identified, the redirection of traffic is critical. In this part of the exercise you will determine alternative traffic routes and identify intersections requiring a police presence.

A. Map detours around the accident scene

1. Open a new blank map document and save it as incident3.
2. Refer back to “Organize and document your work” and do the following:
   a. Document the map.
   b. Set the data frame properties. They must be set for each data frame.
   c. Set the environments.
3. Add the usastreetsnet from the Network Layers feature class. When asked if you want to add all feature classes, click No. The Geographic Coordinate System Warning Menu appears. Click Transformations and choose GCS_WGS_1984 and click OK, then click Close.
4. Add usastreets and in the Symbology tab in the Layers Properties dialog box, import the usastreets layer file.
5. Add counties from the Additional Layers feature class.
6. Add buffer, incident, schools, and sfr from the results folder. The Geographic Coordinate System Warning Menu appears. Click Transformations and choose GCS_WGS_1984, click OK and then click Close.
7. Zoom to the buffer layer.
8. Click the Network Analyst window button on the Network Analyst toolbar to open the dockable window.

9. In the Network Analyst toolbar, click the Network Analyst drop-down menu and click New Route. The Network Window now contains empty lists of Stops, Routes, and Barriers.

10. Right-click Stops (0) in the Network Analyst window and go to Load Locations. Load route1 from the Additional Layers feature class and click OK. When you load route1, stop 1 and 2 appear. These two stops are where road blocks will occur to block the highway. Using these stops, the software will calculate a path (route) around the closed road.

Q11 What road(s) is (are) being closed by these two stops?

Every street that carries traffic within the 0.5-mile buffer zone needs to be closed. First, you must identify the streets that cross into the buffer zone and then insert barriers to keep the traffic out.

11. Select the 0.5-mile buffer zone.

12. Select by location features from the usastreets that "are crossed by the outline of" buffer. Click OK. This selects all the streets that feed into the 0.5-mile buffer zone. This allows you to see which streets need to be closed.
13. Add barriers.

   a. Click Barriers.

   b. Click the Create Network Location tool and place a barrier on every road that enters the 0.5-mile buffer zone.

   It is important that the barriers are actually placed on the roads. For accuracy, use the Magnifier. In the Window menu, click Magnifier to bring up the Magnifier window. You can drag the Magnifier window around by its title bar.
14. After the barriers have been determined, click the Solve button in the Network Analyst toolbar.

A new alternative route is computed, avoiding the barriers.

15. Close the Magnifier window.

16. Right-click Routes (1) in the Network Analyst window and click Export Data.

17. Name the file route1 and store it in your project1_results geodatabase.

18. Right-click Routes in the Network Analyst window and select Directions Window.

**Q12 What is the total distance of the Route 1 detour?**

You need to create two more alternative routes.

19. Right-click Barriers and select Export Data to save the barriers in your results folder so you don’t have to add them again.

20. Name them barriers.

21. Deselect the intersected streets.

22. In the Network Analyst toolbar, click the Network Analyst drop-down menu and click New Route.

23. Right-click Stops (0) in the Network Analyst window and go to Load Locations. Load route2 from the Additional Layers feature class.
Module 1: Project 1

Q13 What road is being closed by these two stops?

24. Right-click Barriers (0) in the Network Analyst window and go to Load Locations and load Barriers from the results folder.

25. Click the Solve button in the Network Analyst toolbar.

26. Right-click Routes (2) in the Network Analyst window and click Export Data.

27. Name the file route2 and store it in your results folder.

28. Right-click Routes in the Network Analyst window and open the Directions window.

Q14 What is the total distance of the Route 2 detour?

29. Repeat the above procedure for Route 3.

Q15 What road is being closed by these two stops?

Q16 What is the total distance of the Route 3 detour?

30. Name the data frame detours.

31. Save the map document.

B. Determine best routes to shelters

1. Copy the detours data frame.

2. Paste it and name the pasted data frame best routes.

3. Collapse the detours data frame.

4. Remove Route1, Route2, and Route3.

5. Zoom to the southern quadrant of the buffer zone. This is the location of residential buildings that have to be evacuated. The southeast quadrant evacuation center is Robert E. Lee High School. The southwest quadrant evacuation center is Lynbrook Elementary School. The police want to establish the best route for evacuees so officers can direct traffic.

6. In the southwest quadrant, the police are starting the evacuation route at 6780 Cabin John Rd., Springfield, VA, 22150, and ending at Lynbrook Elementary School. Prepare the best route so police can direct traffic. Record the mileage and the time.
7. In the Network Analyst toolbar, click the Network Analyst drop-down menu and click New Route.

8. Right-click Stops (0) and select Find Address.

9. Select springfield from the data folder as the address locator.

10. Enter **6780 Cabin John Rd** as the Street and click Find.

   ![Find](image)

11. Right-click the address row to show the context menu and select Add Point. This puts a point at the 6780 Cabin John Rd. address.

12. Close the Find Menu.

13. In the Network Analyst toolbar, click the create Network Location tool and click the graphic point for the 6780 Cabin John Rd. address and then click Lynbrook Elementary School.

14. Click the Solve button in the Network Analyst toolbar to run the process and compute the best route.

15. To save the Route, right-click route(1) in the Network Analyst window and click Export Data. Save the route as **swevac** in the project1_results geodatabase.

16. Remove the route and symbolize swevac.

There are two designated evacuation routes for the southeast evacuation area:

1. The first route goes from 6015 Trailside Drive, Springfield, VA, 22150 to Robert E. Lee High School.
2. The second route starts at 6756 Bison St, goes to 6899 Bowie Drive and ends at Robert E. Lee High School.
17. Repeat steps 11–15 for these two designated routes and name the files seevac2 and seevac3. Remove the routes.

18. Save the map document.

Deliverable 3: A map showing redirected traffic patterns both around the incident and within the buffer zone.

Once your analysis is complete, you’re not done. You still need to develop a solution to the original problem and present your results in a compelling way to the police in this particular situation. The presentation of your various data displays must explain what they show and how they contribute to solving the problem.

Presentation

Write a report documenting your analysis and addressing how you identified the evacuation shelters, road intersections to be closed, and the detour routes. You must explain the spatial patterns you see and describe the implications of your calculations and analysis for this problem. Remember that your audience probably lacks your in-depth knowledge of GIS, so you’ll need to communicate your results in a way that they’ll be able to understand and use.
Scenario
Hazardous materials spills are a source of great concern for local and state law enforcement. In this hypothetical scenario, a tanker truck carrying chlorine gas was westbound on Interstate 85 north of Charlotte in Mecklenburg County, North Carolina. The driver lost control of his truck between the two segments of Interstate 77. The truck left the road and overturned. The impact caused several cracks in the tanker and gas began slowly leaking. The weather was cloudy with no wind.
Problem

North Carolina state troopers arrived at the accident scene first, pinpointed the location with GPS receivers, and identified the leaking gas as chlorine. They then accessed the Material Safety Data Sheet (MSDS) for information about evacuation zones. (The MSDS sheet for chlorine is provided in the Documents folder.) The state troopers immediately needed maps showing the required evacuation zone around the incident, a rough estimate of the population to evacuate, and possible shelter sites for evacuees. They also needed a traffic analysis to determine how best to reroute vehicles and where to pick up evacuees. The response team sought suggestions for a helicopter landing site, both for medical evacuation and to transport personnel for logistical support. The helicopter landing site needed to be close to the incident and the areas of evacuation.

Reminder

It helps to divide a large problem such as this into a set of smaller tasks such as the following:

1. Identify the geographic study area.
2. Determine the sequence of steps in your study.
3. Identify the decisions to be made.
4. Develop the information required to make decisions.
5. Identify stakeholders for this issue.

Deliverables

We recommend the following deliverables for this problem:

1. A map of Mecklenburg County showing roads and schools.
2. A map of buffered areas around the incident. The map should show the following:
   a. Shelter locations
   b. An approximate number of households to be evacuated
   c. Helicopter landing site
3. A map showing redirected traffic patterns both around the incident and from within the buffer zone.

Examine the data

The data for this project is stored in the OurWorld4\Module1\Project2\data folder.

Reminder

You can explore the metadata in ArcCatalog. The table on the following page helps you organize this information.
Q1  Investigate the metadata and complete this table on your worksheet:

<table>
<thead>
<tr>
<th>Layer</th>
<th>Publication Information: Who Created The Data?</th>
<th>Time Period Data Is Relevant</th>
<th>Spatial Horizontal Coordinate System</th>
<th>Data Type</th>
<th>Resolution For Rasters</th>
<th>Attribute Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>bklgrp</td>
<td>Tele Atlas North America, Inc., ESRI</td>
<td>2006</td>
<td></td>
<td>N/A</td>
<td></td>
<td>Demographic Attributes</td>
</tr>
<tr>
<td>aerial</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>gschools</td>
<td></td>
<td></td>
<td></td>
<td>N/A</td>
<td></td>
<td>N/A</td>
</tr>
<tr>
<td>usa-streets</td>
<td></td>
<td></td>
<td></td>
<td>N/A</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Organize and document your work

Reminder
1. Set up the proper directory structure.
2. Create a process summary.
3. Document the map.
4. Set the environments:
   a. Set the Data Frame Coordinate System to be the same as the aerial raster dataset.
   b. Set the Working Directory.
   c. Set the Scratch Directory.
   d. Set the Output Coordinate System to “Same as Display.”

Analysis
An important first step in GIS analysis is to develop a basemap of your study area.
Complete deliverable 1 and answer the questions below to orient yourself to the study area.

Deliverable 1: A map of Mecklenburg County showing roads and schools.
Q2 What main road goes north to south?

Q3 What main road goes west to east?

To continue your analysis you need to know the facts upon which the state troopers and first responders based their decision. The facts and timeline are as follows:

• The first North Carolina trooper on the scene reported the incident position as 80°50’38.76” W, 35°16’23.24”N (-80.8441, 35.273122).
• After talking to the trucker, troopers identified the leaking gas as chlorine.
• They contacted AccuWeather for a weather report. The weather for the rest of the day was cloudy with no wind.
• They carefully read the MSDS and decided to evacuate two miles around the incident and designate shelters that were within one-half mile of the outer perimeter of the evacuation zone.

Using all the information above, continue the analysis to prepare deliverable 2.

Reminder

When you create the multiple buffers, the distances should be 2 and 2.5 miles.

There is no building information with this exercise. You have to use the census block group data to estimate the number of households to evacuate within the two-mile zone.

Clip the block group and then calculate statistics using the households field to estimate the number of households to evacuate. It helps to show the block groups to be evacuated in graduated color by the number of households.

Q4 Which quadrant has the most households to evacuate?

Q5 How many total households must be evacuated?

Extending the project

Your instructor may choose for you to complete this optional exercise.

Create reports on your layout with the names of the schools to be evacuated and the schools that can be used for shelters. Go to Tools and Select Reports and then Create Reports.
Reminder

Because you have set the environments, you must copy and paste the existing Data Frame and rename the pasted data frame for the helicopter landing sites analysis.

Deliverable 2: A map of buffered areas around the incident. The map should show the following:

a. Shelter locations
b. An approximate number of households to be evacuated
c. Helicopter landing site

The final deliverable consists of rerouting traffic both around the incident and from within the evacuation zone to shelters.

Deliverable 3: A map showing redirected traffic patterns both around the incident and from within the buffer zone.

Refer to your process summary from module 1, project 1 and review the procedure for creating barriers and saving them. Create detours 1-5 using the given detour stops layers (detour1stops, detour2stops, etc.).

Q6 Complete the following table on your worksheet:

<table>
<thead>
<tr>
<th>Detours</th>
<th>Mileage</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td></td>
</tr>
<tr>
<td>4</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td></td>
</tr>
</tbody>
</table>
Based on a data analysis, the following schools were designated as shelters. Several were not in the designated half-mile area around the two-mile buffer zone. There were designated pickup areas where buses were sent to evacuate the people with no other means of transportation. The pickup areas and associated shelter schools are listed below:

<table>
<thead>
<tr>
<th>Pick-up area</th>
<th>Designated school shelter</th>
</tr>
</thead>
<tbody>
<tr>
<td>3201 Graham St.</td>
<td>Highland Mill Elementary School</td>
</tr>
<tr>
<td>2201 Lasalle St.</td>
<td>Johnson C. Smith University</td>
</tr>
<tr>
<td>3601 Beatties Ford Rd.</td>
<td>Oakdale Elementary</td>
</tr>
<tr>
<td>4451 Statesville Rd.</td>
<td>Winding Springs Elementary</td>
</tr>
</tbody>
</table>

Create routes from the pickup areas to each of the shelters. Hint—use the usa_streets address locator in the data folder.

Name them route1, route2, route3, and route4, respectively.

**Presentation**

Remember to keep in mind the interests and expertise of your audience as you prepare your presentation. Develop a solution to the original problem and present your results in a compelling way.
You’ve worked through a guided activity on the impact of a hazardous materials spill and repeated that analysis in another community. In this section, you will reinforce the skills you’ve developed by researching and analyzing a similar scenario entirely on your own. First, you must identify your study area and acquire data for your analysis. There are many variations of this activity but consider choosing a scenario that has local impact. Think about chemicals that are transported through your community on railroads, pipelines, and highways. Identify locations such as nuclear power stations, oil refineries, fertilizer plants, gas stations, and dry cleaners that could be the source of hazardous spills. Don’t forget the water. Rivers and lakes could be contaminated depending on where a spill occurs. There are many Web sites that contain extensive collections of Material Safety Data Sheets (MSDS). Make sure to access the appropriate MSDS for your hazardous material.

Refer to your process summary and the preceding module projects if you need help. Here are some basic steps to help you organize your work:

**Research**

Research the problem and answer the following questions:

1. What is the area of study?
2. What is the hazardous material and what are the MSDS constraints?

**Obtain the data**

Do you have access to baseline data? The ESRI Data and Maps Media Kit provides many of the layers of data that are needed for project work. Be sure to pay particular attention to the source of data and get the latest version. Older versions of the ESRI Data and Maps Media Kit are very useful for temporal comparison, so be sure to check the date.

For this exercise, it is imperative that you have access to ESRI Streetmap Data so you can use Network Analyst to calculate detours and evacuation routes. If you obtain data from your local GIS department, make sure to ask for a transportation network along with any other needed data.
If you do not have access to the ESRI Data and Maps Media Kit, you can obtain data from the following sources:

- http://www.esri.com/tiger
- http://www.geographynetwork.com
- http://www.nationalatlas.gov
- http://seamless.usgs.gov (This site allows you to download a high-resolution image.)

**Workflow**

After researching the problem and obtaining the data, you should do the following:

1. Write a brief scenario.
2. State the problem.
3. Define the deliverables.
4. Examine the data using ArcCatalog.
5. Set the directory structure, start your process summary, and document the map.
6. Decide what you need for the data frame coordinate system and the environments.
   a. What is the best projection for your work?
   b. Do you need to set a cell size or mask?
7. Start your analysis.
8. Prepare your presentation and deliverables.

Always remember to document your work in a process summary.